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Getting Started

Welcome

Welcome to the ESAS® Radio Programming software. ERPWin is a Windows® application with
an easy-to-use graphical approach to Uniden radio programming. The software provides user-
friendly, point-and-click menus and commands. It includes: database editing and administration,
radio Read and Write operations, and printing capabilities. A built-in Help Menu provides
additional support as you need it.

This manual introduces you to the software, and takes you through the steps to install the
software on your computer and program a radio.

Important

ERPWin requires Windows 3.0 or higher.

This manual is written with the assumption that you are familiar with Windows, and the basic
keyboard and mouse operations you use to perform the various functions. The manual
instructions also assume that you are familiar with pull-down menus, dialog boxes, and selection
buttons. If you have any questions about these topics, please refer to your Windows and
computer manuals.

You can use ERPWin software to program the SMS318ED, SVS8025TSE, SVS8035TSE,
SPS801TSE or SPS802TSE models for either ESAS® or LTR® operation, depending on your
type of service provided. Before programming these models with ERPWin you should first
check the firmware version to see if it is “ESAS-Ready”. To do this, put the radio into Test
Mode to see if the version corresponds with the following table.

Radio Model Software Version
SMS318ED 1.03 or Higher
SVS8025TSE 1.18 or Higher
SVS8035TSE 1.33 or Higher
SPS801TSE 1.19 or Higher
SPS802TSE 1.19 or Higher

CAUTION: If any unit is programmed with ERPWin and it
DOES NOT have “ESAS-Ready” firmware, the radio will
become corrupted and inoperable. In this happens you should
contact RELM Technical Support for help.

Uniden® is a registered trademark of Uniden America Corporation.
ESAS®is a registered trademark of Uniden America Corporation.
LTR®isa registered trademark of E.F. Johnson Company.
WindOWS® is a registered trademark of Microsoft Corporation
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Installing the Software

l.

2.

Start your computer, and Windows.

Place the Install Disk in the 3.5” floppy drive of your computer.

. In Windows ‘File Manager’ or Program Manager, pull down the File Menu, (or from ‘Start’ in

Windows95 or higher), and click ‘Run’.

. In the Command Line box type: ‘a:\install’. (If your 3.5” drive is not ‘a’, type in the letter of

the drive. Or, you can use the ‘Browse’ command to locate the ‘install.exe’ file on the Install
Disk.)

. Click OK. You’ll see the ESAS logo (like the picture on the front cover), and then the

installation screen.

i
Ly

RPWin Setuj

Welcome to the ERPWin Installation Program.

Please zelect the desired choice.

. The default director for the software is ‘c:\erpwin’. If this is satisfactory, click on the ‘Install’

button.

. The Install software will copy several files to the proper directory. When the installation is

complete, you’ll see the ‘ERPWin Install Installation Complete!” message.

. Click on the “‘OK’ button to complete the installation.

If your running Windows 3.0 or 3.1, a new Program Group will appear in your Program
Manager. In Windows95 and higher, ERPWin 3.0 will be added into your Programs folder.

You are now ready to run the software. When you run ERPWin fo rthe first time, you will need
to set up certain parameters.
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Starting ERPWin

Double-click on the ERPWin Icon. The software will load, and after a few moments you will see
the About ERPWin screen. Please note, latest version is 3.35. All previous versions may
experience problems when running in Windows 95, 98 or Windows NT.
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The Main ERPWin window is now displayed. The Title Bar indicates [new], meaning that the
Database is set to th default values. The bottom of the window indicates imortant information
about the serial interface, Radio Model, and computer control keys.

8 ERF W - |liew
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NOTE:

All illustrated pictures were taken
from ERPWin running in
WindowsNT. There will be some
differences in appearance when
running in Windows 3.0 or 3.1.

There are 5 Pull-Down Menus (File, EditData, Radio, Tools and Help) at the top of the Main
window. There are also 12 icons on the Toolbar just below the Pull-Down Menus. As with most
Windows programs, you can use the icons for shortcuts to some of the commands. You’ll notice
that there are also shortcut keys associated with most of the Pull-Down Menu commands.

Selecting the Appropriate Procedure

The ERPWin software can program a radio for either ESAS or LTR operation. The procedures
you use are different, depending upon how your Services are set up:

A. If your Service includes even one system that is set for ESAS operations, follow the
directions in the Manual section titled “ESAS Programming”.

..Or...
B. If your Service consists of only LTR systems, follow the directions in the Manual section
titled “LTR-Only Programming”™.

No Matter which procedure you use, you have many options of how you’ll set up and save
various configurations of Systems and radios, and how you’ll program individual groups of
radios. This is one of the many plus features of the ERPWin software.
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Description of Menus & Icons
File Menu

EditData Menu

Procedure Pull-Down Menu Shortcut Icon
Key

Resets all screens to default values | New Alt+ N 5
Opens Database file directory Open Alt+ O
Saves file under current name Save Alt+S
Saves file under new name Save As...
Sets communication parameters Session Settings Alt+ G
Prints out currect Database Print Alt+P A=
Views printable Database Print Preview
Sets up printer parameters Printer Setup
Exits the program Exit ESC

Procedure Pull-Down Menu Shortcut Icon

Key
Sets radio ID, Configuration and - . o
3

Permits Configuration F2 .,g
Sets Cell ID, Repeater channels,
Signaling Type, Home Repeater and | Cell Definition F3 EI
Adjacent Cells
Sets Call Names, Call Types, R | i
Destination, Group ID and Links Call Definition F4 £,
Set up pre-stored numbers for B
Selective, Status or Interconnect Destination Book F5 al

calls

Page 1 -4



Description of Menus & Icons Continued

Radio Menu

Procedure Pull-Down Menu Shortcut Icon
Key
Pulls down Radio Model List Select Mode
Reads Data From Radio Read F8 F
Sends Data To Radio Write F9 F

Tools Menu

In this menu there are two selections, Memory Check (Alt+M), that will give you Total Memory
Map Space, Used Memory and Available Memory. Your Total Memory Map Space, with no
Database, is 8192kB, Used Memory is 128kB and Available Memory is 8064kB.

It also diplays the number of Defined Cells, Defined Calls and Defined Destinations in the
present Database. (With no Data all three will be zero.)

Help Menu

Procedure Pull-Down Menu Shortcut Icon
Key
Index to the Help System Help Index F1 W
Directions for using Help Using Help
Information about ERPWin About

Technical Support

For further assistance you may contact RELM Technical Support by calling 800-422-6281.

E-mail: service@RELM.com

.Or...
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Setting up ERPWin

Double-click on the ERPWin icon, in the ESAS Radio Programmer Group (if you are running in
Windows 3.0 or 3.1), or from the Windows Start in Windows95 or higher. The software will
load, and you’ll see the basic screen titled, “ERPWin - [new]”, displaying the “About ERPWin”
version screen. Click ‘OK’ to continue.

The ERPWin program is an application for dealers, distributors and service shops of RELM /
Uniden Land Mobile Radio products. ERPWin provides user friendly, point-and-click, front-end
data base interface along with radio Read and Write, file I/O and printing features. It is used
primarily to program ESAS and L' TR mobiles and portables.

There are several parameters that should be set before programming data.

Setting the Communications Port

The first step you should do before programming is to access the File menu and click on
“Session Settings”, or use the shortcut key [Alt+G]. This menu option provides access control to
the basic serial communication port settings, Radio Model, and paths to DOS-based, radio
programmers for the wide range of Uniden models designed in the past.
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The default Serial Port set up by the program is Com 1. If you are not sure which Com port to
select, go into your Windows Control Panel and check your port settings.

Radio Model sets the default start-up model.

Programmer Path sets the default directories to launch older Uniden programs. PLEASE NOTE,
WHEN USING THE LAUNCH ROUTINE FOR OLDER APPLICATIONS, SUCH AS UNIPRO OR UNIOSP,
OPERATION MAY NOT BE FULLY COMPATIBLE. OLDER UNIDEN PROGRAMS ARE NOT COMPATIBLE WITH

PENTIUM BASED COMPUTERS WITH CLOCK SPEEDS IN EXCESS OF 65MHz.

Make sure you click on ‘Close’ to save your settings. Once you have set up the Session Settings,
you do not need to use this menu option again unless you change your computer setup.

Page 1-6



Programming Radios

Depending on the type of system each radio operates under, you can program the radio for either
ESAS or LTR operation. Here is a brief outline of the steps you’ll use to program radios:

1. Select Radio Model

A. SMS-318ED (Full Duplex Mobile Phone)
B. SVS-8025TSE (Dash Mount Mobile)

C. SVS-8035TSE (Dash Mount Mobile)

D. SPS-801TSE (Portable No DTMF Pad)
E. SPS-802TSE (Portable w/DTMF Pad)

11. Set up the Radio Configuration [F2]

A. Radio ID & Date
B. Serial Number (Optional)

C. Options [Varies, depending on Model selected]
D. ESAS Call Alert Options [Half / Full Duplex]

E. Advanced Features [Permits, Thresholds, DTMF Options, Scan, and Reply Time]

111. Define Cell Definition [F3]

A. Set Cell ID [1 - 127] / Cell Name [Optional]

B. Repeater Channels & Adjacent Cells

C. Signaling Type [ESAS or LTR]

D. Set Area [0 or 1] / Home Repeater [1 20]

E. Talk-Around Repeater [Optional]

F. Roaming Threshold Level [1 -4] / Time-Out-Timers [Dispatch, Phone]

1V. Define Call Definition [F4]
A. Create Call Name

B. Select Call Type [Selective, Status, Interconnect, Dispatch or Talk-Around]
C. Access Priority [1 - 14]

D. LTR Options [Companding, Call Light, Reply ID or TX Inhibited and Group ID]
E. Destination Number and Linking

V. Setup Destination Book [F5]
A. Enter Distination Numbers [1 to 127]

VI. Write Data To Radio [F9]

A. When all items are set correctly, you can program the radio.

Page 1 -7



Configuring the ESAS Radio

ERPWin is setup in such a way to prevent errors of omitting information. This program does not
allow you to enter Call Definitions without Cell Definitions, or Cell Definitions without Radio
Configuration. After all data has been entered and varified, ERPWin will then allow you to Write
to the radio.

Before proceding be sure that you have followed the steps in setting up your communication port as
described on page 1-6. (Refer to page 1-4 and 1-5 for shortcut keys and Icon descriptions.)

Selecting your Radio Model

Again, it is important that you select the correct model to be programmed, otherwise you can
corrupt the firmware.

Pull down the ‘Radio’ Menu. Move the cursor to ‘Select Model’. You will see a list of available
radio models to the right of the menu.

|56 Tool: Help
Select Model - SMS-F18ED
SWS5-B028TSE
SW5-B03RTSE
SPS-B801TSE
v SP5-80 l_'T SE

. Read Fa

TitE t=

Select the model you will be programming, and click on it. In this example we selected the
‘SPS-802TSE’. You will then see a confirming message “SPS-802TSE radio model has been
selected”, press OK to select. You will then see the model name ‘SPS802” in the status bar at
the bottom of ERPWin main screen.

Configuring your Radio

Pull down the ‘EditData’ Menu and click on ‘Configuration’. You’ll see the following screen:
Rafio D (001 - [roa7 Date: 01719771
e [soormas [Bsvancer ]
Dptons SAS Call Abegt Dptions
I Spaei bial T Hall Disples Alest
e
& rerks s |-. L s
% oo s [ ]
M Leck Comments: | E I
iE o LM Communications Test [ile
e B s [ o ]
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Configuring your Radio continued

Enter the information in each of the following fields, as appropriate for the radio and service.

Radio ID
This field is the ESAS radio’s Unique Identification Number (UID). The Radio ID consits of a
3-digit Home Cell Assignment, which is the tower site the radio will primarily operate from, with

a 4-digit extension that is unique for every radio homed on this cell. The default Radio ID is
000-0001.

The proper selection of a Home Cell for any particular radio is important for the operator’s
network management and for better tracking of the unit. Typically, the Home Cell would be the
one the user would normally operate on most of the time. However, the Home Cell can be any
cell in the network from 000 to 127.

The remaining 4 digits of the UID are used by ESAS for trakcing, locating and roaming. Radio
ID’s should not be duplicated. Each site, or “Cell” can use up to 8,192 Unique ID’s.

Date
Any date can be entered in this field in a range from 1/1/1951 to 12/31/2050. This field can be
used to track radio’s warranty status. The default entery is ‘today’s date’.

Serial Number

A radio serial number or any alpha numeric designator, up to 10 characters in length, can be
entered in this field. This information is writen to the unit and will be displayed when unit is put
into test mode.

Although this is an optional field, the use of a serial number is strongly recommended as an aid
for tracking customers’ radios.

Comments

Enter any comment in this field if desired, up to 60 characters in length. The Comments field
does not get programmed into the radio, it is only stored in the data file. For example, it could be
used to reference any updates or changes in customers’ data file.

Options

There are several options available, but not with all models. They vary according to model
selection. Selections not available will be grayed out. The following compatiability chart shows
available options-to-models.
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Option Compatibility Chart

SMS318ED | SVS8025TSE | SVS8035TSE | SPS801TSE | SPS802TSE
Speed Dial | Always ON No No No No
Receive
Page Yes Yes No Yes Yes
Connect
Tone Yes Yes Yes Yes Yes
Group
Scan Yes Yes Yes Yes Yes
Horn-Honk Yes Yes Yes No No
Lock Yes Yes Yes Yes Yes
Auto Yes Yes Yes No No
Power-Off
VOX No No No Yes Yes
Busy
System Yes Yes Yes Yes Yes
Queue

Options

Speed Dial

This option enables radio’s feature of recalling numbers stored in the speed dial memory buffer,
which is stored on the ESAS switch. (Only available on the SMS318ED and is always set to ‘On’.

Receive Page
If this option is enabled, the radio (with exception of SVS8035TSE) will be able to receive pages.

Connect Tone

This feature enables and disables an audible “beep’ that sounds when the radio successfully accesses
a repeater.

Group Scan
With this feature you can disable or enable the radio’s search feature of all Call Groups that belong
to the same system.

Horn-Honk

This feature enables or disables the mobile’s Horn Alert function to ‘honk’ the vehicles horn when
radio receives a call. For proper operation, external horn relay is required (not provided by factory).
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Options Continued

Lock

This option enables radio’s feature to lock the Keypad to prevent unauthorized use. (ESAS systems
also have the ability to Lock a radio from accessing the site, even when this feature is disabled. If
this happens your radio will display “KEYS LOCKED” and can only be cleared by your service
provider.)

Auto Power-Off

This option enables or disables the automatic Power-Off feature of a radio (not available for SPS801
or SPS802). With this feature is enabled, the radio ignition sense line detects when the vehicle is
turned off and starts the auto power-off timer. Refer to your operators guide for the particular
model your programming for setting the times.

VOX (Voice Operated Transmit)

This feature enables and disables Voice Operated Transmit. It is only available for the SPS801 and
SPS802 portables. For the option to work correctly you must have a compatible headset wired
according to factory specifications.

Busy System Queue
When all the repeaters in the system are busy, the radio monitors the system and will automatically
place your call when a repeater becomes free, if busy system queuing is enabled.

Half Duplex Alert

If this box is checked, the radio’s call indicator will flash and the horn signal (in case of the
SVS8035TSE) will be activated when a half-duplex call is received and the Horn-Honk feature is
enabled.

Full Duplex Alert

If this box is checked, the radio’s call indicator will flash and the horn signal (in case of the
SVS8035TSE) will be activated when a full-duplex call is received and the Horn-Honk feature is
enabled.

NOTE: You can have both both half and full duplex alerts enabled.
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Advanced Radio Configuration

~Badio Permits - _Roaming Thresholds
Detectlun R ate Sampling Time

800+ Calling min. SEC.

0+ Calling 1: I j I_j Iﬁj
1+ Calling I_
Directory Assistance 2 L j I_j Iﬁj
Speed-Dialing 3 |5I] :I I1—:I IH:I
Speed-Dial Programming 4 |5|] :I |1_:| IF:I
Call-'w aiting

Call-Forwarding

Call Reply Time: |3_i| SBC.

Call Transfer

R Scan Hiztory Depth: IB i’ cells
Receive Telco Calls "DTMF Options
Network Dispatch Auto-Dial Delay Time: I 200 - ms

Yoice Loc. Prompts

Status-Messaging Digit Length: | 40 - | ms
Companding Interdigit Delay: I 40 |-l ms

Tracking
Hang-Up Sequence: Ilﬂt
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Advanced Radio Configuration

Clicking on the ‘Advanced...” button takes you to the Advanced Radio Configuration screen for
additional radio configuration options, Radio Permits, Roaming Thresholds, Call Reply Time, Scan
History Depth and DTMF options, Auto Dial Delay Time, Digit Length, Interdigit Delay and Hang-
up Sequence. Please note that the program comes with all the Radio Permits default set enabled. It
is best to leave all permits on when radio is used on an ESAS site. After checking in to its’ home
cell the Service Class applied to the radio at the switch site overrides all the radio permit settings
and can be controlled by the service provider. On LTR systems, Radio Permits are not used.

Roaming Threshold

This section has a group of four settings (levels), each comprised of frame Detection Rate and
frame Sampling Time. It is best to use the default settings unless you know your system and
network well and want to optimize it.

The Detection Rate sets the percentage of digital protocol that the radio receives correctly. The
Sampling Time sets the time for sampling frames of digital data. Each of the four threshold levels
consists of two parameters: the number of collected cells, and the collection time. Each cell is
programmed with one of the four levels.

In order for a mobile to roam, its roaming threshold must be reached. If the Sampling Time or the
Detection Rate values are too extreme, roaming may occur too frequently, or the radio may never
roam. When optimizing, it is best to change the Samplng Time and leave the Detection Rate at
50%.
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Advanced Radio Configuration Continued...

Call Reply Time

This is the length of time the radio stays on the received Call before resuming scan, after the Call is
dropped. The default setting is 3 seconds. You may need to adjust this setting according to your
customers needs.

Scan History Depth
This sets the parameter for the Adaptive Scan feature for the number of cells to store in its history
buffer which can be from 1 to 8 cells. The default value is 8 cells.

The radio can adjust the system scan sequence to favor systems on which calls were recently received.
The Scan History Depth determines how many calls are recorded. Once it reaches its capacity, the
oldest call will be dropped from the buffer and replaced when the next call is received. The calls
stored in the buffer will be added into the scan sequence to reduce the chance of missing calls.

DTMF Options
In this field you can set Auto Dial Delay Time, Digit Length, Interdigit Delay and Hang-Up Sequence.

Auto Dial Delay Time sets a time period the radio will wait before starting the automatic dialing
sequence. You can choose between 100ms to 3000ms in 200ms increments. The default value is
200ms.

Digit Length allows you to sets the lenght of time for a DTMF digit, anywhere from 30ms to
1000ms. The SVS8035TSE default time is 200ms, all other models are 40ms.

Interdigit Delay sets the off time between DTMF digits. Default values are the same as the Digit
Length.

Hang-Up Sequence allows you to set a DTMF code of up to 4 characters for ending interconnect
calls. This sequence will be transmitted at the end of the call. Valid values are 1-9,A,B,C, D, *
or #. ERPWin default sequence is blank. Ifthis field is left blank, the radio sends “#” character to
the repeater for the time of 1.5 seconds to end the interconnect call.

When you have completed all the necessary entries, click on ‘Close’. This will save your Advanced
Radio Configuration and return to the Radio Configuration screen. Click on ‘Close’ again to return

to the main screen.

You are now ready to continue to the next step, Cell Definition.
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Cell Definition

Cell Definition is an ESAS term used to describe a system at a particular sight. The Uniden ESAS
models can have up to 128 Cell Definitions, or Systems, numbered from 0 to 127. Just like Systems,
in an LTR configuration, there are 20 repeater channels per Cell. Below is the Cell Definition
screen with sample information included. Default screen shows Cell ID, Cell Name, Home Repeater
and Talk-Around with blank windows and the Signaling Type is set to ESAS.

Cell Definition X |

Cell ID: | 001 =]  CellName: [RELM ONE

Delete

Repeaters ® Area 0 Cl Area 1 Clianaeld

Swgnaling Type: I LTR J
Adj t Cell
ESERS Roaming Threshold Level: |1 j
Time-Out Timer —————————— BT I
Home Hepeater: IB ﬁ Dizpatch: |3l] sBC JJ ITI
Cloze

T alk-Around: Iﬂ—il Phone: | 3 min J

Cell ID
The first step in setting up your cells, or systems is to click on ‘New’ and enter your Cell ID. You
must enter a number from 0 to 127. If you are setting up for ESAS the cell ID must match the cell
number of the sight your are using. On LTR systems it doesn’t matter, just as long as you enter a
number.

Cell Name
The Cell Name is optional. Normally you would use this field to identify the sight or system
location. It is not written into the radio, but it is saved with the * . ERP file.

Area

The Area reflects the area bit used by the cell or system. Normally, you should set this area bit to 0
unless you are defining a co-channel system. (Co-Channel is defined as another system with identical
repeater channels usually located outside the fringe area of your main system. The Area bit prevents
from accessing both systems.)

Signaling Type

If the edited cell is an ESAS system, and you want the radio to operate as an ESAS radio, select
ESAS. For straight LTR operation, select LTR signaling.
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Roaming Threshold Level

The Roaming Threshold Level selects one of the four levels that were configured in the Radio
Configuration Advanced screen. (See the Advanced Configuration for more details.) It is best to
use the default values unless you know your system and network well and want to optimize it. You
can skip this field when using LTR signaling.

Repeaters

The Repeaters dialog box is used to edit frequency or channel numbers for each repeater. Each
system can have up to 20 repeaters and the repeater number must match with that used by the
switch at the cell site.

There are two ways to enter the repeater parameters. One way is with the Frequency radio button.
This allows you to enter the exact frequency on each repeater. Or you can edit by Channel which
allows you to enter by FCC channel numbers. You will notice that when entering by Frequency,
the channel number will be displayed after you go to next repeater, or when you press the TAB key.
Likewise when you enter by Channel the frequency will be displayed.

Check the Offset box next to the desired repeater number to set frequency 12.5kHz lower. The
offset frequency will be displayed.

After all your repeater channels/frequencies have been entered select ‘Close’. This takes you back
to the Cell Difinition screen.
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Adjacent Cells

On the Adjacent Cells dialog screen you can build a list of cells that link to the current cell. This is
a parameter of Adaptive Scan which tells an ESAS radio which cell to scan next. Only those,
previousl defined cells, can be used for building the adjacent cell list. In order to work properly, the
Adjacent Cells must be defined one after another, starting from adjacent cell number 1, and without
any gaps in between. The consequences of programming otherwise may be unpredictable.

- _-J‘-II'_J a3 e
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Example

You have 10 sites in a regional network but they are spread out over a 300-mile area. Your customers
typically do not travel throughout the entire area very often. You would only enter the other 3 sites
that were immediately adjacent to the user’s main site. The radio would still roam automatically to

the other 6 sites of the network, when it gets in range.

Home Repeater:

The Home Repeater refers to the repeater number selected from the Repeaters screen as the home
repeater on the cell. You must enter a number in this field before you can save the file. Otherwise
ERPWin will prompt you with ‘Home repeater required!” warning. And if you select a repeater
number that has not been assigned, ERPWin will prompt you with ‘Invalid Home repeater!” warning.

You can type in the repeater number, or use the Up/Down buttons to select it.

Talk-Around

This optional feature, know as TAC (Talk-Around Channel), allows two-way communication without
going through the system. If you define at least one Call of TAC type on a particular cell, in order
to properly function, the Talk-Around Repeater number has to be the same as the Home Repeater
number. This allows the TAC channel to be included in the Scan List. Also, the Signaling Type
should always be LTR.

Talk-Around call groups can be set up in two ways:

1. Defined as a separate cell - in this case the frequency can be defined regardless of any Cell’s
Base stations or Repeaters. This increases memory consumption but allows a different Home
Channel to be assigned for TAC.

2. Defined as part of an existing cell - in this case frequency is defined as part of the existing Cell’s
frequencies and uses the same Home Channel. This save memory consumption.

Time-Out Timer
This feature sets the transmit duration each time an ESAS radio keys up for a dispatch call and a
phone call separately. The radios send warning tones to the operator before cutting off.

When you have finished, click on the ‘Save’ button to save all the entries. If the Cell Definition
screen is not completed properly you will not be able to go to the next step.

If you wish to make a change to an existing Cell ID, select the Cell to change and click on ‘Change
Id’ button. To erase a Cell click on ‘Delete’.

After you have completed entering all your information and have saved it, click close to go to the
next step, ‘Call Definition’.
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Call Definition Part 1

The Call Definition dialog box is used to create, edit or delete calls that the ESAS radio will be
placing or receiving.
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Call Name

The first step is to select New. You will see the Add Call Name dialog asking you to enter the new
unique Call Name. All ESAS models accepts up to 10 alphanumeric characters, with the exception
of the SMS318ED which allows 0, 1,2, 3, 4, 5, 6,7, 8, 9. -. space and upper/lower case A, B, C, D,
E,F,G,H,LL, O, P, S, Z. This unique Call Name is what the user sees on the radio display.

Call Type

Now you need to select the Call Type. There are several to choose from. If you want to make an
ESAS Extended Call or Null Call with a UID (Unique ID), choose SELECTIVE. For ESAS Status/
Message call, select STATUS (STS) for your Call Type.

For LTR Calls setect either DISPATCH, INTERCONNECT, TALK-AROUND, or FULL DUPLEX
for your Call Type.

DISPATCH Group ID (GID) Call Type, is for LTR systems and uses Group ID codes 0 - 250.

On INTERCONNECT Repeater InterConnect (RIC) Call Type, use with Half-Duplex radios for
telephone interconnect on non-ESAS sysems; use with Full Duplex radios in special applications
only (eg. Auto-Connect).

TALK-AROUND Channel (TAC), which is not available on Full Duplex radios, should only be
used on LTR systems.

FULL DUPLEX (RIC) is for Full Duplex radios only on non-ESAS systems.
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Call Definition Part 11

Call Type Tip

Ifyou are using an ESAS radio on ESAS calls, do not use RIC codes. Instead, setup a SELECTIVE
Call Type, which will draw a dial tone and can be used to manually place phone calls throughout
the entire network. Phone numbers or another radio number can also be pre-stored in the radio as
SELECTIVE (UID) calls and will function the same way.

You will also notice that when selecting ESAS Call Types, the LTR Options become inactive. The
only way to access L TR Options is to select LTR Call Types Interconnect, Dispatch, Talk-Around
or Full Duplex.

Access Priority

(If you are using L'TR only Call Types skip this section.) After entering your Call Name and Call
Type, set your Access Priority level. Default value is 8. ESAS sites limit loading by inhibiting the
access attempts from low priority radios when the system loading exceedsd defined limits. The
lowest level priority would be 1 and the highest level is 14.

Cell Id

This is a pull-down list of all the Cell’s that were entered in the Cell Definition screen. Click on the
down arrow and select the Cell Id that you want the Call Name to associate with. The radio will
not operate if the Call Names and Cell Id’s do not match up to your system parameters. One way to
check, is to make sure the Cell Name that appears with your Cell Id corresponds with correct
repeater channels and Home Repeater that were entered in the Cell Definition screen.

Destination
In general, this field contains the list of destination numbers for SELECTIVE, STATUS, and
INTERCONNECT Call Types.

A radio number, telephone number, message, page, or a special call such as a networked dispatch
can be setup by the switch when it receives the data pre-stored in this field.

If left empty, a so called Null Call is created, which draws a dial tone and the operator can dial
directly any combination of numbers.

Only those, previously defined destination entries, entered into the Distination Book, will show up
in the drop-down list.

Group ID

The Group ID field contains the LTR transmit and receive ID’s that make group dispatch and LTR
Interconnect calls possible and is only accessable with LTR Call Types. The Transmit ID specifies
the ID used in the LTR transmit packet and the Receive Range specifies the lower and upper range
for listening to LTR receive packets.
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Call Definition Part 111

Link
Use this selection to link calls together. Individual calls can be linked to other calls for form Call
Groups. Call linking affects the way in which the radio scans, roams and initiates calls.

NOTE: Linking TAC Calls to other calls is not generally recommended.

A user has 4 ESAS sites. The first call in the call group is named “Local Dispatch™” and defines a
GID call (“DISPATCH” Call Type) on the “Dallas” system. The call is selectable. This call is
linked to a GID call defined on the “Fort Worth” system, which is linked to a GID call on the
“Weatherford” system, which is in turn linked to a call on the “Wichita Falls” system. The last

three calls are not selectable.
"Wichita
Falls”
"Weatherford"

"Fort Worth" .
"Local
Dispatch"

When the “Local Dispatch™ Call Group is selected, and the radio is checked into “Dallas”, the
Dallas GID is used. When the “Local Dispatch” radio leaves the “Dallas™ area it starts roaming and
will check into the first available site. The GID selection is made automatically by the radio as it
roams from site to site without any intervention from the operator.

A use has 4 ESAS sites with a dispatcher on Site 1. The dispatcher uses a GID difined on Site 1.
When using Site 1, the user talks to the dispatcher on the dispatcher’s GID. When roamed into one
of the other 3 sites out of Site 1’s range, the user still needs to communicate with the dispatcher.

Program the radio with a Call Group containing two calls. The first call on Site 1, is a dispatch call
using the dispatcher’s GID. This call is selectable. Link this call to a second non-selectable
“SELECTIVE” Call, with a destination number specifying the dispatcher’s GID. Now, no matter
which cell the radio checks into, all calls initiated by the radio will be routed to the dispatcher’s
GID at Site 1.
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Call Definition Part IV
Linking Calls

A customer goes between Tulsa and Oklahoma City on a regular basis and has dispatch groups in
each city. The Call Group may be set up as a GID on the Tulsa ESAS system with TX/RX ID’s.
This Call Group is selectable and linked to another Call Group (set up previously) named “OK
CITY”. The Oklahoma City Call Group is also a GID on an ESAS system in Oklahome City with
different TX/RX ID’s, and is not user-selectable (see Call Selectable).

When the radio is checked into Tulsa, it will automatically use the Tulsa system. When out-of-
range of Tulsa, and checked into the ESAS system in Oklahoma City, it will automatically use the
Oklahoma City ID’s. All this occurs without the user touching his radio or changing Call Groups.

Call Selectable

Make sure that you ‘x’ the Call Selectable box if you want the Call to be displayed on the radio and
allow the user to manually select it. To create effective links and virtual connections do not check
this box. The call then will be automatically used by the radio as part of a linked call, while
remaining transparent to the user.

Continue entering all your data in the Call Definition screen. Once you have completed each Call
Name, select Save to save your data. You may Delete or Change a Call Name at any time. Your
Call Names will be displayed in the Call Name drop-down list in the order that you put them in.

Close the Call Definition screen to go back to main menu. You can now program your radio at this
time. Or go to the Destination Book to enter Destination Numbers.

Destination Book
The Destination Book is used for pre-storing call destinations for ESAS and interconnect types of
calls. It is also used for LTR only radios if pre-stored telephone numbers are defined.

You can scroll through the list by using the vertical scrollbar. Clicking on a record will display its
Destination Number and index Entry#. At this point, the entry can be edited, saved or deleted.

| Destination Book x
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Special Features

Tools

The Tools menu selection provides access to Memory Check, which shos memory consumption of
the 8K code plug space, and DOS-based programming applications for the LTR radios. In order to
execute the programmers, they must be present in the directories specified in the Programmer Path
section of the Session Settings screen.

Warning: You may have some problems running the DOS-based programs. If you do, we
recommend you discontinue using this feature of ERPWin and run all DOS-based programs straight
from DOS.

Trouble Shooting

NOTE: You can not read Factory Test Data.

“Radio connection error!”

If you get a “Radio connection error!”, check to make sure the AMXS501 is connected properly to
the radio to be programmed. If you are programming a mobile or full duplex model, it must be
powered up and the RED LED on the AMX501 should be on. Ifitis a portable type radio, you must
have the 12 Volt adapter connected to the AMXS501. If everything is powered up correctly and you
still get this error message, you should check the radio for any internal defects around the mic
connector.

“Hardware error!”

If you get “Hardware error”, you should check the Session Settings to make sure you have the
correct COM port selected. (Special note: The AMXS501 will not work on the printer port. It must
be connected to Serial port.) If you are sure that it is connected to the correct port and are still
getting error message, consult your computer technician to see if there is an IRQ conflict.

ERPWin only works on ESAS models. You should always check the radio firmware version before
atempting programming. If the firmware is not ESAS type, the radio will be corrupted. If you have
any questions, call technical support at 800-445-5017 or 800-422-6281.
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